NEC NEAX 2400 PIMG Integration Guide for
Cisco Unity Connection 1.2

Revised October 12, 2007

This document provides instructions for integrating the NEC NEAX 2400 phone system with
Cisco Unity Connection by using the Intel NetStructure PBX-IP Media Gateway (PIMG).

Integration Tasks

Before doing the following tasks to integrate Cisco Unity Connection with the NEC NEAX 2400 phone
system, confirm that the Cisco Unity Connection server is ready for the integration by completing the
applicable tasks in the Cisco Unity Connection Installation Guide.

The following task list describes the process for creating an integration.

Task List to Create the Integration

st
CISCO.

Use the following task list to set up a new integration with the NEC NEAX 2400 phone system. If you
are installing a new Cisco Unity Connection server by using the Cisco Unity Connection Installation
Guide, you may have already completed some of the following tasks.

1. Review the system and equipment requirements to confirm that all phone system and Cisco Unity
Connection server requirements have been met. See the “Requirements” section on page 2.

2. Plan how the voice messaging ports will be used by Cisco Unity Connection. See the “Planning How
the Voice Messaging Ports Will Be Used by Cisco Unity Connection” section on page 4.

3. Program the NEC NEAX 2400 phone system and extensions. See the “Programming the NEC
NEAX 2400 Phone System” section on page 6.

4. Set up the PIMG units. See the “Setting Up the PIMG Units” section on page 8.

5. Create the integration. See the “Creating a New Integration with the NEC NEAX 2400 Phone
System” section on page 15.

6. Test the integration. See the “Testing the Integration” section on page 18.
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M Requirements

7. If this integration is a second or subsequent integration, add the applicable new user templates for
the new phone system. See the (Multiple Integrations Only) Adding New User Templates, page 21.

Requirements

The NEC NEAX 2400 integration supports configurations of the following components:

Phone System
e One of the following NEC NEAX 2400 phone systems:

- IMG
- IMX
— IPX (release 15 or later)

¢ One or more of the applicable PIMG units. For details, refer to the “Supported Circuit-Switched
Phone System Integrations” section of Cisco Unity Connection System Requirements, and
Supported Hardware and Software at
http://www.cisco.com/en/US/products/ps6509/prod_installation_guides_list.html.

e The voice messaging ports in the phone system connected by digital lines to the ports on the PIMG
units.

We recommend that you connect the voice messaging ports on the phone system to the ports on the
PIMG units in a planned manner to simplify troubleshooting. For example, the first phone system
voice messaging port connects to the first port on the first PIMG unit, the second phone system voice
messaging port connects to the second port on the first PIMG unit, and so on.

e The PIMG units connected to the same LAN or WAN that Cisco Unity Connection is connected to.
e If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

— For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

— For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

— No network devices that implement network address translation (NAT).
— A maximum 200 ms network latency.

e The phone system ready for the integration, as described in the documentation for the phone system.

Cisco Unity Connection Server

¢ Cisco Unity Connection installed and ready for the integration, as described in the Cisco Unity
Connection Installation Guide at
http://www.cisco.com/en/US/products/ps6509/prod_installation_guides_list.html.

¢ A license that enables the applicable number of voice messaging ports.
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Integration Description

Integration Description

The NEC NEAX 2400 PIMG integration sends call information and voice connections through the
digital lines, which connect the phone system to the PIMG units. The PIMG units communicate with the
Cisco Unity Connection server through the LAN or WAN by using Session Initiation Protocol (SIP).
Figure 1 shows the required connections.

Figure 1 Connections Between the Phone System and Cisco Unity Connection
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Call Information

The phone system sends the following information with forwarded calls:

e The extension of the called party

¢ The extension of the calling party (for internal calls) or the phone number of the calling party (if it
is an external call and the system uses caller ID)

e The reason for the forward (the extension is busy, does not answer, or is set to forward all calls)

Cisco Unity Connection uses this information to answer the call appropriately. For example, a call
forwarded to Cisco Unity Connection is answered with the personal greeting of the user. If the phone
system routes the call to Cisco Unity Connection without this information, Cisco Unity Connection

answers with the opening greeting.

Integration Functionality

The NEC NEAX 2400 integration with Cisco Unity Connection provides the following features:
e (Call forward to personal greeting
e C(Call forward to busy greeting

e Caller ID

e Easy message access (a subscriber can retrieve messages without entering an ID because
Cisco Unity Connection identifies the subscriber based on the extension from which the call

originated; a password may be required)

NEC NEAX 2400 PIMG Integration Guide for Cisco Unity Connection 1.2
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e Identified subscriber messaging (Cisco Unity Connection identifies the subscriber who leaves a
message during a forwarded internal call, based on the extension from which the call originated)

e Message waiting indication (MWI)

Integrations with Multiple Phone Systems

Cisco Unity Connection can be integrated with multiple phone systems at one time. For information on
and instructions for integrating Cisco Unity Connection with multiple phone systems, refer to the
Multiple Phone System Integration Guide at
http://www.cisco.com/en/US/products/ps6509/products_installation_and_configuration_guides_list.ht
ml.

Planning How the Voice Messaging Ports Will Be Used by
Cisco Unity Connection

Before programming the phone system, you need to plan how the voice messaging ports will be used by
Cisco Unity Connection. The following considerations will affect the programming for the phone system
(for example, setting up the hunt group or call forwarding for the voice messaging ports):

e The number of voice messaging ports installed.
e The number of voice messaging ports that will answer calls.

e The number of voice messaging ports that will only dial out, for example, to send message
notification, to set message waiting indicators (MWIs), and to make telephone record and playback
(TRAP) connections.

The following table describes the voice messaging port settings in Cisco Unity Connection that can be
set on Telephony Integrations > Port of Cisco Unity Connection Administration.

Table 1 Settings for the Voice Messaging Ports
Field Considerations
Enabled Check this check box to enable the port. The port is enabled during normal operation.

Uncheck this check box to disable the port. When the port is disabled, calls to the port get
a ringing tone but are not answered. Typically, the port is disabled only by the installer
during testing.

Extension Enter the extension for the port as assigned on the phone system.

Answer Calls Check this check box to designate the port for answering calls. These calls can be
incoming calls from unidentified callers or from users.

Perform Message Notification Check this check box to designate the port for notifying users of messages. Assign
Perform Message Notification to the least busy ports.

Send MWI Requests Check this check box to designate the port for turning MWIs on and off. Assign Send MWI

Requests to the least busy ports.
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Planning How the Voice Messaging Ports Will Be Used by Cisco Unity Connection I

Table 1 Settings for the Voice Messaging Ports (continued)
Field Considerations
Allow TRAP Connections Check this check box so that users can use the port for recording and playback through the

phone in Cisco Unity Connection web applications. Assign Allow TRAP Connections to
the least busy ports.

Outgoing Hunt Order

Enter the priority order in which Cisco Unity Connection will use the ports when dialing
out (for example, if the Perform Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest numbers are used first. However,
when multiple ports have the same Outgoing Hunt Order number, Cisco Unity Connection
will use the port that has been idle the longest.

The Number of Voice Messaging Ports to Install

The number of voice messaging ports to install depends on numerous factors, including:
e The number of calls Cisco Unity Connection will answer when call traffic is at its peak.
e The expected length of each message that callers will record and that users will listen to.
e The number of users.
¢ The number of ports that will be set to dial out only.
e The number of calls made for message notification.
e The number of MWIs that will be activated when call traffic is at its peak.

e The number of TRAP connections needed when call traffic is at its peak. (TRAP connections are
used by Cisco Unity Connection web applications to play back and record over the phone.)

e The number of calls that will use the automated attendant and call handlers when call traffic is at its
peak.

It is best to install only the number of voice messaging ports that are needed so that system resources are
not allocated to unused ports.

The Number of Voice Messaging Ports That Will Answer Calls

The calls that the voice messaging ports answer can be incoming calls from unidentified callers or from
users. Typically, the voice messaging ports that answer calls are the busiest.

You can set voice messaging ports to both answer calls and to dial out (for example, to send message
notifications). However, when the voice messaging ports perform more than one function and are very
active (for example, answering many calls), the other functions may be delayed until the voice messaging
port is free (for example, message notifications cannot be sent until there are fewer calls to answer). For
best performance, dedicate certain voice messaging ports for only answering incoming calls, and
dedicate other ports for only dialing out. Separating these port functions eliminates the possibility of a
collision, in which an incoming call arrives on a port at the same time that Cisco Unity Connection takes
the port off-hook to dial out.

The Number of Voice Messaging Ports That Will Only Dial Out, and Not Answer Calls

Ports that will only dial out and will not answer calls can do one or more of the following:
¢ Notify users by phone, pager, or e-mail of messages that have arrived.
e Turn MWIs on and off for user extensions.

e Make a TRAP connection so that users can use the phone as a recording and playback device in
Cisco Unity Connection web applications.
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I Programming the NEC NEAX 2400 Phone System

A

Typically, these voice messaging ports are the least busy ports.

Caution

In programming the phone system, do not send calls to voice messaging ports in Cisco Unity Connection
that cannot answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice
messaging port is set only to Send MWI Requests, do not send calls to it.

Preparing for Programming the Phone System

Record your decisions about the voice messaging ports to guide you in programming the phone system.

Programming the NEC NEAX 2400 Phone System

A

If you use programming options other than those supplied in the following procedure, the performance
of the integration may be affected.

Caution

Step 1

Step 2
Step 3
Step 4

Step 5
Step 6

Step 7

In programming the phone system, do not send calls to voice messaging ports in Cisco Unity Connection
that cannot answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice
messaging port is set only to Dialout MWI, do not send calls to it.

Do the following procedure.

To Program the NEC NEAX 2400 Phone System by Using the Command Line Interface

Log on to the NEC NEAX 2400 administration terminal and go to the Maintenance Command Menu
page.
On the Maintenance Command Menu page, enter 14 (Installation).

On the Installation Menu page, enter 3 (ASYD) to assign system data.

Enter the following settings.

Table 2 Assignment of System Data Settings
Field Setting

Sys 1

Index 78

Data 0B

On the Maintenance Command Menu page, enter 6 (Station Data).

On the Station Data Commands page, enter 3 (ASTN) to assign the station numbers for the voice
messaging ports.

On the Station Number Assignment page, enter the extension for the first port that will connect to the
PIMG unit.

A

Caution  Confirm that the station number (extension) is not already assigned. Otherwise, the
integration will not function correctly.
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Programming the NEC NEAX 2400 Phone System Il

Step8  On the Station Data Commands page, enter 2 (ASCL).
Step9  On the Station Class Data page, assign the applicable station class information to the voice messaging
port.
Step10 On the Station Data Commands page, enter 1 (ASDT).
Step11  On the Station Data page, in the LENS field, enter the applicable line equipment number for the voice
messaging port.
Step12  On the Station Data Commands page, enter 5 (AKYD).
Step13  On the Key Data page, select Assignment/Change and press Enter.
Step14 On the Assignment of Key Data page, enter the following settings to enable the PRIMARY
APPEARANCE function on Key 1.
Table 3 Assignment of Key Data Settings for Key 1
Field Setting
KYN 1
KYI 2
Step15 Press Esc to move to the next operation.
Step16  Enter the following settings to enable the MWL SET function on Key 5.
Table 4 Assignment of Key Data Settings for Key 5
Field Setting
KYN 5
FKI 9
Step17 Press Esc to move to the next operation.
Step18  Enter the following settings to enable the MWL CNCL function on Key 6.
Table 5 Assignment of Key Data Settings for Key 6
Field Setting
KYN 6
FKY 11
Step19 On the Maintenance Command Menu page, enter 13 (Restriction Data).
Step20  On the Restriction Data Commands page, enter 2 (ASFC).
Step21  On the Service Feature Assignment page, enter the following settings.

Table 6 Service Feature Assignment Settings
Field Setting
TN:1 SFI1:74
TN:1 SFI1:82
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Step 22

Program each phone to forward calls to the pilot number assigned to the voice messaging ports, based
on one of the Cisco Unity call transfer types shown in Table 7.

Table 7 Call Transfer Types
Transfer Type Usage
Release transfer Program the phone to forward calls to the pilot number when:

(blind transfer) e The extension is busy.

e The call is not answered.

Supervised transfer Program the user station to forward calls to the pilot number only when
the call is not answered (on the phone system, the number of rings
before forwarding must be more than the number of rings to supervise
the call). Confirm that call forwarding is disabled when the extension is
busy.

Setting Up the PIMG Units

Step 1

Step 2

Step 3
Step 4
Step 5
Step 6

Do the following procedures to set up the PIMG units that are connected to the NEC NEAX 2400 phone
system.

These procedures require that the following tasks have already been completed:
e The phone system is connected to the PIMG units by using digital lines.
e The PIMG units are ready to be connected to the LAN or WAN.
e The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default
values of all fields, see the documentation for the PIMG unit.

To Download the PIMG Firmware Update Files for Digital PIMG Units

On a Windows workstation that will have access to the PIMG units, open a web browser and go to the
Cisco Unity PIMG Software Download page at
http://www.cisco.com/cgi-bin/tablebuild.pl/unity-PIMG.

~

Note  To access the software download page, you must be logged on to Cisco.com as a registered user.

On the Cisco Unity PIMG Software Download page, click the most recent version of the firmware for
digital (DNI) PIMG units.

On the Details page, click Next.
On the Document page, click Accept.
In the Enter Network Password dialog box, enter your user name and password, then click OK.

In the File Download dialog box, click Save.

r NEC NEAX 2400 PIMG Integration Guide for Cisco Unity Connection 1.2
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Step 7

Step 8

Step 9
Step 10
Step 11

Step 1

Step 2
Step 3
Step 4

Step 5
Step 6
Step 7
Step 8

Step 9
Step 10
Step 11

Setting Up the PIMG Units 1l

In the Save As dialog box, browse to the Windows workstation that will have access the PIMG units,
browse to a directory where you want to save the file, and click Save.

In the Download Complete dialog box, click Open. The window for extracting the PIMG firmware
update files appears.

Click Extract.
In the Extract dialog box, browse to the directory where you want the extracted files, and click Extract.

Close the window for the extracting application.

To Set Up the Digital PIMG Units

On the Windows workstation, add a temporary route to enable access to the PIMG units.
a. On the Windows Start menu, click Run.
b. Enter emd, and press Enter. The Command Prompt window appears.

c. At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press
Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add
10.12.13.74<space>198.1.3.25” in the Command Prompt window.

d. Close the Command Prompt window.
Connect a PIMG unit to the network.
In the web browser, go to http://10.12.13.74.

On the System Login page, enter the following case-sensitive settings.

Table 8 System Login Page Settings
Field Setting

Username admin

Password IpodAdmin

Click Log On.

On the Configure menu, click Upgrade.
On the Upgrade page, click Browse.

In the Choose File dialog box, browse to the directory on the Windows workstation that has the extracted
PIMG firmware update files.

Click Ami<xx>.app (where <xx> is multiple digits), and click Open.
On the Upgrade page, click Install.
After the file is installed, a message prompting you to restart the PIMG unit appears. Click Cancel.

A

Caution Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if
the file installation fails. Restarting the PIMG unit at this step may prevent the PIMG unit
from functioning correctly.

[ oL-10604-08

NEC NEAX 2400 PIMG Integration Guide for Cisco Unity Connection1.2 g



NEC NEAX 2400 PIMG Integration Guide for Cisco Unity Connection 1.2 |

Il Setting Up the PIMG Units

Step12 Repeat Step 6 through Step 11 for each of the following files:
e Ami_<xx>.fsh
e Run<xx>FskEcho.dsp
e iNim<xx>.ibt
¢ iNim<xx>.ilc
¢ iNim<xx>.iap
Step13  On the Configure menu, click Upgrade.
Step14  On the Upgrade page, click Browse.
Step15 In the Choose File dialog box, browse to the file DNI_Cfg_Generic.ini.
Step16 Click DNI_Cfg_Generic.ini, and click Open.
Step17  On the Upgrade page, click Install.
Step 18  After the file is installed, a message prompting you to restart the PIMG unit appears. Click OK.
Step19 In the web browser, go to http://10.12.13.74.

Step20 On the System Login page, enter the following case-sensitive settings.

Table 9 System Login Page Settings
Field Setting

Username admin

Password IpodAdmin

Step21 Click Log On.
Step22 On the Configure menu, click Password.

Step23 On the Password page, enter the following settings.

Table 10 Password Page Settings
Field Setting
Old Password IpodAdmin

(This setting is case sensitive.)

New Password <your new password>

(This setting is case sensitive.)

Confirm Password <your new password>

(This setting is case sensitive.)

Step24 Click Change.
Step25 On the Configure menu, click System.
Step26 On the System page, enter the following settings.

NEC NEAX 2400 PIMG Integration Guide for Cisco Unity Connection 1.2
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Step 27
Step 28
Step 29
Step 30

Step 31
Step 32
Step 33

Setting Up the PIMG Units

Table 11 System Page Settings
Field Setting
Operating Mode SIP
Telephony Switch Type |NEC_NEAX
PCM Coding uLaw

Click Apply Changes.

On the Configure menu,

click Gateway.

On the Gateway page, click the Gateway Routing tab.

On the Gateway Routing tab, enter the following settings.

Table 12 Gateway Routing Tab Settings
Field Setting
Fault Tolerance No
Enabled
Load Balancing No
Enabled
VoIP Endpoint ID: <the IP address of the Cisco Unity Connection server>
1
VoIP Endpoint ID: <blank>
2
Click Apply Changes.

Click the Gateway Advanced tab.

On the Gateway Advanced tab, enter the following settings.

Table 13 Gateway Advanced Tab Settings
Field Setting
Call Connect Mode OnAnswer

Destination for
Unroutable PBX Calls

<the extension of an attendant who will receive calls to Cisco Unity
Connection that are unanswered>

Turn MWI On FAC <blank>
Turn MWI Off FAC <blank>
Wait for Yes
Ringback/Connect on

Blind Transfer

Hunt Group Extension

<the pilot number for the Cisco Unity Connection voice messaging ports>

Audio Compression

Click the preferred codec for audio compression:
e G.711 Only
* G.729 A Preferred

[ oL-10604-08
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Table 13 Gateway Advanced Tab Settings (continued)
Field Setting
Signaling Digit Relay |Off
Mode
Voice Activity Off
Detection
Frame Size Click the applicable setting:
e G.711—20
e G.729a—10

A

Caution  Failure to use the correct setting will result in recorded messages
containing nothing but silence.

Frames Per Packet Click the applicable setting:
e G.711—1
e G.729a—2

A

Caution  Failure to use the correct setting will result in recorded messages
containing nothing but silence.

Call Control QOS (PIMG units connect only to a LAN) 0
Byte (PIMG units connect to a WAN) 104

S,

Note  For details on the setting for a LAN, see the caveat CSCsb96387.

RTP QOS Byte (PIMG units connect only to a LAN) 0
(PIMG units connect to a WAN) 184

~

Note  For details on the setting for a LAN, see the caveat CSCsb96387.

Step34 Click Apply Changes.
Step35 Click the Gateway Capabilities tab.
Step36 Depending on how you have planned to use the voice messaging ports, click the applicable setting for

each port in the Telephony Port Capability column.

Table 14 Gateway Capabilities Tab Settings

Telephony Port Capability Settings |Voice Messaging Port Usage

Calls-Only The port will answer incoming calls only and will not dial out
(for example, to set MWIs or send message notifications).
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Step 37
Step 38
Step 39

Step 40
Step #1
Step 42

Setting Up the PIMG Units 1l

Table 14 Gateway Capabilities Tab Settings (continued)

Telephony Port Capability Settings |Voice Messaging Port Usage

MWIs-Only The port will dial out only (for example, to set MWIs or send
message notifications) and will not answer incoming calls.

Both The port will answer incoming calls and will also dial out (for
example, to set MWIs or send message notifications).

A

Caution  In setting up the PIMG unit, do not send calls to ports in Cisco Unity that cannot answer calls
(voice messaging ports that are not set to Answer Calls). For example, if a voice messaging
port is set only to Dialout MWI, do not send calls to it. Otherwise the integration will not
function correctly.

If a port in Cisco Unity Connection is disabled, click No in the Telephony Port Enabled column for the
corresponding port on this tab. Note that changing a setting in the Telephony Port Enabled column
requires restarting the PIMG unit.

Click Apply Changes.
On the Configure menu, click SIP.
On the SIP page, enter the following settings.

Table 15 SIP Page Settings

Field Setting

Host and Domain Name <the domain name of the PIMG unit>
Server Port 5060

Primary Proxy Server Address |<the IP address of the Cisco Unity Connection server>

Primary Proxy Server Port 5060

(When you configure more than one PIMG unit, increase this setting
by 1 for each successive unit. For example, unit 2 will be 5061,
unit 3 will be 5062, and so on.)

Proxy Query Interval 10
T1 Time 400
T2 Time 3000

Click Apply Changes.
On the Configure menu, click IP.
On the IP page, enter the following settings.
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Step 43
Step 44
Step 45

Step 46

Step 47

Step 48

Step 49

Step 50

Step 51

Table 16 IP Page Settings
Field Setting
Client IP Address <the new IP address you want to use for the PIMG unit>

(This is the IP address that you will enter in Cisco Unity Connection
Administration when you create the integration.)

Client Subnet Mask <the new subnet mask, if the subnet mask is different from the default IP

address>
Default Network <the IP address of the default network gateway router that the PIMG units will
Gateway Address use>
BOOTP Enabled No

Click Apply Changes.
On the Configure menu, click Tones.

On the Tones page, click the Learn tab.

A

Caution  Destination addresses cannot be duplicated in the same session. Otherwise, the process for
learning tones will not succeed. If you do not have enough available phones to learn all the
tones at one time, you can run multiple sessions to learn tones individually by checking or
unchecking the applicable Acquire Tone check boxes.

On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and leave
the Destination Address field blank.

On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and do
the following substeps to verify that the tone is correct.

a. From a available phone, call a second phone.

b. Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c¢. From a third phone, dial one of the busy phones.

d. Confirm that you hear a busy tone.

e. Hang up the third phone but leave the handsets for the other two phones off.

On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed
in Step 47c. from the third phone.

On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is
checked and do the following substeps to verify that the tone is correct.

a. From an available phone, dial an extension that does not exist.
b. Confirm that you hear the reorder or error tone.
c¢. Hang up the phone.

On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that you
dialed in Step 49a.

On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked
and do the following substeps to verify that the tone is correct.

a. From an available phone, dial an extension that does exist

NEC NEAX 2400 PIMG Integration Guide for Cisco Unity Connection 1.2
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Step 52

Step 53

Step 54
Step 55
Step 56
Step 57
Step 58
Step 59

Creating a New Integration with the NEC NEAX 2400 Phone System I

b. Confirm that you hear the ringback tone.
c¢. Hang up the phone.

On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you
dialed in Step 51a.

Click Learn.

~

Note  When running learn tones, the PIMG unit will restart after learning the first tone. For details, see
the caveat CSCsh53791.

When the process is complete, check the check box for each newly learned tone and click Apply.
Hang up the phones that you used in Step 47.

On the Configure menu, click Restart.

On the Restart page, click Restart Unit Now.

When the PIMG unit has restarted, in the View menu, click Refresh.

Repeat Step 2 through Step 58 on all remaining PIMG units.

Creating a New Integration with the NEC NEAX 2400 Phone
System

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

Step 7

Step 8

After ensuring that the NEC NEAX 2400 phone system and Cisco Unity Connection are ready for the
integration, do the following procedures to set up the integration and to enter the port settings.

To Create an Integration

Log on to Cisco Unity Connection Administration.
In Cisco Unity Connection Administration, expand Telephony Integrations, then click Phone System.

On the Search Phone Systems page, on the Phone System menu, click New Phone System. The Phone
System Integration Wizard appears.

On the Select Phone System Manufacturer page, in the Manufacturer field, click NEC and click Next.
On the Select Phone System Model page, in the Model field, click NEAX 2400 and click Next.

On the Set Up Phone System page, in the Phone System Name field, accept the default name or enter the
descriptive name that you want, and click Next.

On the Select Port Group Template page, in the Port Group Template field, click Digital PIMG to NEC
NEAX 2400 and click Next.

On the Set Up Port Group page, enter the following settings and click Next.
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Table 17 Settings for the Set Up Port Group Page
Field Setting
Port Group Name <a descriptive name for the port group; accept the default name or enter the

name that you want>

Number of Ports 8

(If you want to use fewer than eight voice messaging ports, enter the
number of voice messaging ports that you want to use on this PIMG unit.)

IP Address or Host Name |<the IP address of the PIMG unit that you are integrating with Cisco Unity
Connection>

Test Address Click this button to test the IP address that you entered. The results of the
test appear in the field to the right of the button.

Port <the SIP port of the PIMG unit that Cisco Unity Connection will connect
to; we recommend that you use the default setting>

A

Caution  This setting must match the setting for the Server Port field of the
PIMG unit. Otherwise the integration will not function correctly.

Step9  On the Confirm Phone System Settings page, confirm the settings that you have entered and click Finish.
Step10  On the Phone System Creation Summary page, click Close.
Step11  In Cisco Unity Connection Administration, expand Telephony Integrations, then click Port.
Step12  On the Search Ports page, click the display name of the first voice messaging port that you created for
this phone system integration.
>
Note By default, the display names for the voice messaging ports are composed of the port group
display name followed by incrementing numbers.
Step13  On the Port Basics page, set the voice messaging port settings as applicable. The fields in the following
table are the ones that you can change.
Table 18 Settings for the Voice Messaging Ports
Field Considerations
Enabled Check this check box to enable the port. The port is enabled during normal operation.
Uncheck this check box to disable the port. When the port is disabled, calls to the port get
aringing tone but are not answered. Typically, the port is disabled only by the installer
during testing.
Extension Enter the extension for the port as assigned on the phone system.

Answer Calls

Check this check box to designate the port for answering calls. These calls can be
incoming calls from unidentified callers or from users.

Perform Message Notification Check this check box to designate the port for notifying users of messages. Assign

Perform Message Notification to the least busy ports.

Send MWI Requests

Check this check box to designate the port for turning MWIs on and off. Assign Send MWI
Requests to the least busy ports.
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Table 18 Settings for the Voice Messaging Ports (continued)
Field Considerations
Allow TRAP Connections Check this check box so that users can use the port for recording and playback through the

phone in Cisco Unity Connection web applications. Assign Allow TRAP Connections to
the least busy ports.

Outgoing Hunt Order Enter the priority order in which Cisco Unity Connection will use the ports when dialing
out (for example, if the Perform Message Notification, Send MWI Requests, or Allow
TRAP Connections check box is checked). The highest numbers are used first. However,
when multiple ports have the same Outgoing Hunt Order number, Cisco Unity Connection
will use the port that has been idle the longest.

Step14  Click Save.
Step15 Click Next.
Step16 Repeat Step 13 through Step 15 for all remaining voice messaging ports for the phone system.

Step 17  If another phone system integration exists, in Cisco Unity Connection Administration, expand
Telephony Integrations, then click Trunk. Otherwise, skip to Step 21.

Step18  On the Search Phone System Trunks page, on the Phone System Trunk menu, click New Phone System

Trunk.
Step19  On the New Phone System Trunk page, enter the following settings for the phone system trunk and click
Save.
Table 19 Settings for the Phone System Trunk
Field Setting

From Phone System |<the display name of the phone system that you are creating a trunk for>

To Phone System <the display name of the previously existing phone system that the trunk will
connect to>

Trunk Access Code |<the extra digits that Cisco Unity Connection must dial to transfer calls
through the gateway to extensions on the previously existing phone system>

Step20 Repeat Step 18 and Step 19 for all remaining phone system trunks that you want to create.

Step21 If prompted to restart Cisco Unity Connection, in the Windows task bar, right-click the Cisco Unity
Connection icon and click Restart > Voice Processing Server Role.

Step22 When prompted to confirm stopping the Voice Processing server role, click Yes.

Step23 In Cisco Unity Connection Administration, in the Related Links drop-down list, click Check Telephony
Configuration and click Go to confirm the phone system integration settings.

If the test is not successful, the Task Execution Results displays one or more messages with
troubleshooting steps. After correcting the problems, test the connection again.

Step24 In the Task Execution Results window, click Close.
Step25 Log off Cisco Unity Connection Administration.
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Testing the Integration

Step 1

Step 2

Step 3

Step 4
Step 5

Step 6
Step 7
Step 8

Step 9

Step 10
Step 11
Step 12

To test whether Cisco Unity Connection and the phone system are integrated correctly, do the following
procedures in the order listed.

If any of the steps indicate a failure, refer to the following documentation as applicable:
e The installation guide for the phone system.

e The setup information earlier in this guide.

To Set Up the Test Configuration

Set up two test extensions (Phone 1 and Phone 2) on the same phone system that Cisco Unity Connection
is connected to.

Set Phone 1 to forward calls to the Cisco Unity Connection pilot number when calls are not answered.

A

Caution  The phone system must forward calls to the Cisco Unity Connection pilot number in no fewer
than four rings. Otherwise, the test may fail.

To create a test user for testing, in Cisco Unity Connection Administration, expand Users, then click
Users.

On the Search Users page, on the User menu, click New User.

On the New User page, enter the following settings.

Table 20 Settings for the New User Page

Field Setting

User Type User with Voice Mailbox
Based on Template <the applicable user template>
Alias testuser

First Name Test

Last Name User

Display Name Test User

Extension <the extension of Phone 1>
Click Save.

On the Edit User Basics page, in the Voice Name field, record a voice name for the test user.

In the Phone System field, confirm that the phone system selected is the phone system that Phone 1 is
connected to.

Uncheck the Set for Self-enrollment at Next Login check box.
Click Save.
On the Edit menu, click Message Waiting Indicators.

On the Message Waiting Indicators page, click the message waiting indicator. If no message waiting
indication is in the table, click Add New.

NEC NEAX 2400 PIMG Integration Guide for Cisco Unity Connection 1.2
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Step13 On the Edit Message Waiting Indicator page, enter the following settings.
Table 21 Settings for the Edit MWI Page
Field Setting
Enabled Check this check box to enable MWIs for the test user.
Display Name Accept the default or enter a different name.

Inherit User’s Check this check box to enable MWIs on Phone 1.
Extension

Step14 Click Save.

Step15 On the Edit menu, click Transfer Options.

Step16  On the Transfer Options page, click the active option.

Step17  On the Edit Transfer Option page, under Transfer Action, click the Extension option and enter the
extension of Phone 1.

Step 18  In the Transfer Type field, click Release to Switch.

Step19 Click Save.

Step20 Minimize the Cisco Unity Connection Administration window.

Do not close the Cisco Unity Connection Administration window because you will use it again in a later
procedure.

Step21  On the Cisco Unity Connection desktop, double-click the Tools Depot icon.

Step22 In the left pane of the Tools Depot window, expand Switch Integration Tools, then double-click Port
Status Monitor. The Port Status Monitor window appears.

Step23  On the Ports menu, click Start All, and arrange the port monitors so that you can notice which port will
handle the calls that you will make.

To Test an External Call with Release Transfer

Step 1 From Phone 2, enter the access code necessary to get an outside line, then enter the number outside
callers use to dial directly to Cisco Unity Connection.

Step2  In the Port Status Monitor, note which port handles this call.

Step3  When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting
means that the port is configured correctly.

Step4  Confirm that Phone 1 rings and that you hear a ringback tone on Phone 2. Hearing a ringback tone means
that Cisco Unity Connection correctly released the call and transferred it to Phone 1.

Step5  Leaving Phone 1 unanswered, confirm that the state of the port handling the call changes to “Idle.” This
state means that release transfer is successful.

Step6  Confirm that, after the number of rings that the phone system is set to wait, the call is forwarded to
Cisco Unity Connection and that you hear the greeting for the test user. Hearing the greeting means that
the phone system forwarded the unanswered call and the call-forward information to Cisco Unity
Connection, which correctly interpreted the information.

Step7  On the Port Status Monitor, note which port handles this call.

NEC NEAX 2400 PIMG Integration Guide for Cisco Unity Connection 1.2
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Step 8
Step 9

Step 10

Step 1
Step 2

Step 3

Step 4
Step 5
Step 6

Step 7
Step 8

Step 1

Step 2
Step 3
Step 4

Step 1

Step 2
Step 3

Leave a message for the test user and hang up Phone 2.

In the Port Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This
state means that the port was successfully released when the call ended.

Confirm that the MWI on Phone 1 is activated. The activated MWI means that the phone system and
Cisco Unity Connection are successfully integrated for turning on MWIs.

To Test Listening to Messages

From Phone 1, enter the internal pilot number for Cisco Unity Connection.

When asked for your password, enter the password for the test user. Hearing the request for your
password means that the phone system sent the necessary call information to Cisco Unity Connection,
which correctly interpreted the information.

Confirm that you hear the recorded voice name for the test user (if you did not record a voice name for
the test user, you will hear the extension number for Phone 1). Hearing the voice name means that
Cisco Unity Connection correctly identified the user by the extension.

Listen to the message.
After listening to the message, delete the message.

Confirm that the MWI on Phone 1 is deactivated. The deactivated MWI means that the phone system and
Cisco Unity Connection are successfully integrated for turning off MWIs.

Hang up Phone 1.

On the Port Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This
state means that the port was successfully released when the call ended.

To Set Up Supervised Transfer on Cisco Unity Connection

In Cisco Unity Connection Administration, on the Edit Transfer Option page for the test user, in the
Transfer Type field, click Supervise Transfer.

In the Rings to Wait For field, enter 3.
Click Save.
Minimize the Cisco Unity Connection Administration window.

Do not close the Cisco Unity Connection Administration window because you will use it again in a later
procedure.

To Test Supervised Transfer

From Phone 2, enter the access code necessary to get an outside line, then enter the number outside
callers use to dial directly to Cisco Unity Connection.

On the Port Status Monitor, note which port handles this call.

When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting
means that the port is configured correctly.
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Step 4

Step 5

Step 6

Step 7
Step 8

Step 9

Step 1
Step 2
Step 3

(Multiple Integrations Only) Adding New User Templates ||

Confirm that Phone 1 rings and that you do not hear a ringback tone on Phone 2. Instead, you should
hear the indication your phone system uses to mean that the call is on hold (for example, music).

Leaving Phone 1 unanswered, confirm that the state of the port handling the call remains “Busy.” This
state and hearing an indication that you are on hold mean that Cisco Unity Connection is supervising the
transfer.

Confirm that, after three rings, you hear the greeting for the test user. Hearing the greeting means that
Cisco Unity Connection successfully recalled the supervised-transfer call.

During the greeting, hang up Phone 2.

On the Port Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This
state means that the port was successfully released when the call ended.

Exit the Port Status Monitor.

To Delete the Test User

In Cisco Unity Connection Administration, expand Users, then click Users.
On the Search Users page, check the check box to the left of the test user.
Click Delete Selected.

(Multiple Integrations Only) Adding New User Templates

When you create the first phone system integration, this phone system is automatically selected in the
default user template. The users that you add after creating this phone system integration will be assigned
to this phone system by default.

However, for each additional phone system integration that you create, you must add the applicable new
user templates that will assign users to the new phone system. You must add the new templates before
you add new users who will be assigned to the new phone system.

For details on adding new user templates, refer to the “Adding, Changing, or Deleting an Account
Template” chapter in the Cisco Unity Connection User Moves, Adds, and Changes Guide at
http://www.cisco.com/en/US/products/ps6509/prod_maintenance_guides_list.html.

For details on selecting a user template when adding a new user, refer to the applicable chapter for adding
user accounts in the Cisco Unity Connection User Moves, Adds, and Changes Guide at
http://www.cisco.com/en/US/products/ps6509/prod_maintenance_guides_list.html.
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Appendix: Documentation and Technical
Assistance

Conventions

The NEC NEAX 2400 PIMG Integration Guide for Cisco Unity Connection 1.2 uses the following

conventions.
Table 22 NEC NEAX 2400 PIMG Integration Guide for Cisco Unity Connection 1.2 Conventions
Convention Description

boldfaced text

Boldfaced text is used for:
e Key and button names. (Example: Click OK.)

e Information that you enter. (Example: Enter Administrator in the User
Name box.)

<>

(angle brackets)

Angle brackets are used around parameters for which you supply a value.
(Example: In the Command Prompt window, enter ping <IP address>.)

(hyphen)

Hyphens separate keys that must be pressed simultaneously. (Example: Press
Ctrl-Alt-Delete.)

>

(right angle
bracket)

A right angle bracket is used to separate selections that you make:

e On menus. (Example: On the Windows Start menu, click Programs >
Cisco Unified Serviceability > Real-Time Monitoring Tool.)

¢ In the navigation bar of Cisco Unity Connection Administration. (Example:
In Cisco Unity Connection Administration, expand System Settings >
Advanced.)

[x]

(square brackets)

Square brackets enclose an optional element (keyword or argument). (Example:
[reg-e164])

[x Iyl

(vertical line)

Square brackets enclosing keywords or arguments separated by a vertical line
indicate an optional choice. (Example: [transport tcp | transport udp])

{x1ly}

(braces)

Braces enclosing keywords or arguments separated by a vertical line indicate a
required choice. (Example: {tcp | udp})

The NEC NEAX 2400 PIMG Integration Guide for Cisco Unity Connection 1.2 also uses the following

conventions:

Note = Means reader take note. Notes contain helpful suggestions or references to material not covered in the

document.
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A

Obtaining Documentation, Obtaining Support, and Security Guidelines ||

Caution

Means reader be careful. In this situation, you might do something that could result in equipment
damage or loss of data.

For descriptions and URLs of Cisco Unity Connection documentation on Cisco.com, see the

About Cisco Unity Connection Documentation. The document is shipped with Cisco Unity Connection
and is available at
http://www.cisco.com/en/US/products/ps6509/products_documentation_roadmaps_list.html.

Obtaining Documentation, Obtaining Support, and Security

Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback,
security guidelines, and also recommended aliases and general Cisco documents, see the monthly
What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical
documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

CCVP, the Cisco logo, and Welcome to the Human Network are trademarks of Cisco Systems, Inc.; Changing the Way We Work, Live, Play, and Learn is
a service mark of Cisco Systems, Inc.; and Access Registrar, Aironet, Catalyst, CCDA, CCDP, CCIE, CCIP, CCNA, CCNP, CCSP, Cisco, the Cisco
Certified Internetwork Expert logo, Cisco 10S, Cisco Press, Cisco Systems, Cisco Systems Capital, the Cisco Systems logo, Cisco Unity,
Enterprise/Solver, EtherChannel, EtherFast, EtherSwitch, Fast Step, Follow Me Browsing, FormShare, GigaDrive, HomeLink, Internet Quotient, IOS,
iPhone, IP/TV, iQ Expertise, the iQ logo, iQ Net Readiness Scorecard, iQuick Study, LightStream, Linksys, MeetingPlace, MGX, Networkers,
Networking Academy, Network Registrar, PIX, ProConnect, ScriptShare, SMARTnet, StackWise, The Fastest Way to Increase Your Internet Quotient,
and TransPath are registered trademarks of Cisco Systems, Inc. and/or its affiliates in the United States and certain other countries.

All other trademarks mentioned in this document or Website are the property of their respective owners. The use of the word partner does not imply a
partnership relationship between Cisco and any other company. (0711R)

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and
figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and
coincidental.

© 2007 Cisco Systems, Inc. All rights reserved.
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